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Introduction 
 
 
Stirlitz Media Inspector (SMI) is advanced software that recognizes 'known audio files' in audio-
streams or audio logs and reports detailed analyses on the usage of this audio in standard or 
customized web based reports. SMI uses 'Advanced Media Fingerprinting' techniques that enable 
it to recognize known audio even in non optimal environments and when the audio source has sped-
up or slowed-down the audio. 
 
SMI is fully scalable and runs on standard PCs under Windows 2008/2008 R2 or Windows 7.  
 
Small installations, inspecting several audio sources, can run on a single computer. But if you need 
to inspect multiple sources in markets all over the country, this is no problem either. All system 
elements, the recording modules (SML Server), search modules (SMI Server), SQL server and 
WWW interface can be located on different computers, running in different locations, either 
connected through a local network or through Internet. 
 
 
Main system elements: 
 
1. SMI Server 

a. Main Search (FingSearch) – search, audio conversion, system configuration 
b. DbMain – track patterns (songs, commercials etc.) management 
c. ImportPatterns – automatic import of new tracks (songs, commercials etc.) 

2. Web Interface 
a. PostgreSQL server 
b. WWW Server with PHP support (Apache, IIS) 
c. SMI WWW Interface 

3. SML Server 
a. Log audio 
b. Audio conversion to data files 

4. SML Player 
 
 
Term definitions: 
 
Track song, commercial, jingle or any other audio file 
Pattern data file of track stored in the SMI database, containing metadata and complete set 

of fingerprints of Track 
Key 3 seconds long part of the Pattern, kept in memory by search application, used for 

preliminary identification 
Station source of audio to be 'inspected' 
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System architecture 
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How it works 
 
 
SMI compares 'patterns' with incoming audio streams or previously logged audio. 
 
To do this SMI needs two types of input data: 
 
- Incoming or logged audio – converted to a pre-processed format either by the SML server or by 

the SMI server itself. Pre-processed data files are approximately 80MB/day/station  
 

- Patterns – created from audio files, with extra metadata (like Artist, Title, Category etc.). One 
Pattern is approximately 100kb. These patterns can be created manually using the DbMaint 
application or automatically using the ImportPatterns application. 

 
The number of Keys to be taken from a Pattern can be pre-defined. A Key is a data file representing 
3 seconds of audio from the Pattern. These Keys are used in the preliminary search in the incoming 
or recorded audio. When a Key is identified, the system will load the Pattern of the whole Track and 
will try to identify the beginning and the end of the Track. 
 
For good quality audio archives (like recorded from FM) three keys per Track are enough. It is 
recommended however to increase the number of keys for searching in lower quality audio such as 
web streams. You can go as far as you want, for example one Key for every 15 seconds of the Track 
(so 12 keys for a 180 seconds song). Please note however that the consequences of using many 
Keys in a Pattern are lower system performance and higher memory use. 
 
The SMI search algorithm can find Patterns as short as 0.5 seconds. Please be aware that when 
searching for Patterns that short, the false results level will be increased. For Patterns longer than 10 
seconds the level of false and missed hits is minimal and will only occur in the event of audio 
disturbance in the incoming or logged audio file. 
 
The SMI search algorithm automatically compensates for multiple signal disruptions such as 
compression or noise. But for the correct identification of audio played at modified speeds (such as 
music played out faster in some radio stations) special options have to be enabled while creating the 
Patterns. 
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Step-by-step installation manual 
 
Installation of  
- SMI Server 1.0 
- SMI Web Interface 
- PostgreSQL Server 
- IIS Server on Windows XP 
 
The SMI Server, SQL Server and Web Server (IIS or Apache + PHP) can be installed on different 
computers connected by a TCP/IP connection, or on single computer, running Windows XP or 
2003. The SQL and Web server can be also hosted on other operating systems (like Linux), but 
those configurations are not officially supported.  Multiple SMI Servers can use the same SQL 
database, but only if they are using the same Patterns database (located on a shared network folder). 
 
The recorded installation procedure is an integral part of this manual. You can download it here: 
On-line version: http://static.stirlitzmedia.com/presentations/SMI_Install/ 
Off-line version: http://static.stirlitzmedia.com/presentations/SMI_Install.zip 
 
Please watch it before or during installation. 
 
Step 1: 
 
- Disable automatic system updates, and automatic system restart after the installation of updates. 
- Change Windows regional options to English (US). SMI may work incorrect with other settings. 
- It’s recommended to setup automatic login, to start SMI automatically on Windows startup 
- Please note, that SMI has to run on account which is member of Administrators users group 
 
Step 2: 
 
Install PostgreSQL Server 8.1 or newer (if not yet installed) 
 
Step 3: 
 
Install WWW server (if not yet installed) 
We recommend using IIS Web Server running on Windows XP 
 
Step 4: 
 
install PHP and SMI Web Interface (if using Windows as SQL/WWW server) 
- extract packages PHP_5_2_SMI_preconfigured.exe and SMIServer_www_interface_php.exe, 

on the computer with the WWW server (Windows).  
- After extraction, import c:\php\_registry_ini_location.reg into the system registry, and add 

'c:\php' to system path. 
 
Step 5: IIS configuration (if using IIS on Windows XP) 
 
- Add the php isapi filter (c:\php\php5isapi.dll) to IIS Web Sites configuration.  
- Change IIS documents root to c:\SMIServer_www 
- Add index.php to the Default documents list 
- Restart IIS 
 
 

5 Stirlitz Media Inspector - manual 
 

http://static.stirlitzmedia.com/presentations/SMI_Install/
http://static.stirlitzmedia.com/presentations/SMI_Install.zip


Step 6: IIS and PHP check 
 
Open http://localhost/info.php in your web browser on the www server, to check configuration.  
 
Step 7: SMI Server installation 
 
- Install SMIServer_version.exe 
- Run c:\SMIServer\bin\info.exe, send the codes together with your company name to 

activation@StirlitzMedia.com.  
- Save the license file you will receive by e-mail to c:\SMIServer.  

[Please note that the license file generation is a manual process and that it may take a couple of 
hours before you receive the license file] 

 
Step 8: SQL Configuration 
 
- Run the PostgreSQL management tool 
- connect to the SQL server 
- create a new user 
- create a new database, be sure to use utf8 encoding 
 
Step 9: SMI Web Interface configuration 
 
- on the WWW Server computer, open c:\SMIServer_www\inc\config.inc.php using Notepad 
- enter the correct sql database access parameters: $dbhost, $dbport, $dbname, $dbuser, $dbpass  
- save the modified file 
 
Step 10: SMI Server – first configuration 
 
- Run SMI Main Search for the first time 
- Accept the global configuration 
- Refer to the 'SMI Server – Main Search (Fingsearch) Configuration' chapter below for more 

information 
 
Step 11: SMI Server – first station  
 
- In SMI Main Search, create a new station 
- Configure the new station, including SQL configuration 
- Refer to the 'SMI Server – Main Search (Fingsearch) Configuration' chapter below for more 

information 
- Right click the station, and select ‘Start search’ 
 
Step 12: Final check 
 
Open http://localhost/ in the web browser on the www server, to check if SMI web-interface is 
running correctly. 
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SMI Server – Main Search (Fingsearch) Configuration 
 
 
Global configuration 
 
Click Configuration... in Fingerprints Database section to show Main Configuration window.  
 

 
Available options: 
 
Patterns Database Path 
location of fingerprints (songs, jingles, commercials) database. It can be absolute (like 
c:\fingeprints) or relative (like ..\fingdb) path.  
Base path for all relative paths is c:\SMIServer\bin 
 
Process priority 
priority of the main search application. NORMAL is the default and recommended value. 
 
Search Engine Memory 
memory (in MB) used by the main search engine. This value should not be higher than 50% of the 
total memory installed in the computer. For 32 bit systems (Windows XP or 2003) the maximal 
value is 512. 
 
Imports 
 
Click Configuration in Patterns Importer section to show the Imports - Configuration window.  
This configuration dialog defines rules for auto-import of songs, jingles, commercials and all other 
audio files into the patterns (fingerprints) database.  
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Available options: 
 

 
Click Add button to show Add import item window.  
 

 
 
Folder: source folder containing the audio files 
Metadata import mode: mode of importing information such as 'Artist' and 'Title' 
Audio decoder: mp3 – for mp3 files, wave – for uncompressed wave files, DirectShow – for all files 
which Windows Media Player can play 
Category: category to assign imported files 
Files extension: extension of files to import. Use * to import all files from source folder 
Number of keys: number of 3 second long fragments, which are used for the primary identification 
of audio. Higher number = higher accuracy = lower search speed. Recommended values are 3 for 
short tracks (advertisements, jingles), 5 for medium sized files (songs). Increase these values to 
compensate poor incoming audio quality. 
Import file on various speeds:  identify songs on stations that are playing tracks in different speeds 
(usually a few percent faster). Import files in resampled versions, faster or slower than the original. 
 
Click OK to accept changes, or Cancel to ignore them. 
 
Click Edit or Remove buttons to modify Imports - Configuration items.  
Click OK to accept changes, or Cancel to ignore them. 
You have to start the 'PatternsImporter' application to start the automatic importing. Click Start in 
Patterns Importer section to launch the process. 
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WWW Interface 
 
Click Configuration in WWW Interface section to show the WWW 
Interface  window. Use Add and Remove buttons to define categories. 
Use Color button to define color for category. Selected colors will be 
used in WWW Interface to identify audio. 
 
 
Stations 
 
Use Add/Edit/Duplicate/Remove buttons in the Stations section to add/remove/modify stations 
items. Each item (station) indicates a single processing unit which is processing source audio data 
(from a recorded radio station), and produces results visible as a single station in the WWW 
Interface. 
 

 
 
Station name 
Station name, as it will be displayed in WWW Interface 
 
 
Pre-processed database location 
Location of the pre-processed audio archive (recorded 
audio converted to the SMI pre-processed format).   
There are three options available:  
- No conversion - to use archived files, or pre-processed 

files created directly by the SML server (only version 
2.5 or newer) 

- Direct conversion from the sound card – to create pre-
processed files directly from sound card 

- Conversion from SML – to create pre-processed files from SML (any version) audio files. 
 

Make sure these categories 
correspond with the categories 
as set in the 'Imports - 
Configuration window'. 

When creating or duplicating a 
station, click the Generate Defaults 
button after entering the name of the 
station. This will generate the 
default values.  
Do not click this button while 
editing the stations settings. 
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Max size of database 
Number of days of pre-processed files to keep. Keep 0 to disable automatic delete. 
 
WWW Interface – background color 
Define the color that will be used in the WWW interface for the station. 
 
Logs output path 
Folder where the history log files will be saved. They can be used by SML or to integrate the SMI 
search results in other applications. 
Leave blank to disable.  
 
PGSQL Address/Database/User/Password 
Details for PostgreSQL database access. Leave blank if you are not using SMI Web Interface. 
 
SML Server URL 
URL address of the SML server containing audio for the station.  
Format: sml://server_address:server_port/Station_name/ 
(Note: You need SML Player 2.5n or newer to use this function) 
 
Conversion Interval 
Indicates how often the conversion process (conversion from SML archive) will be executed. 
 
Merge precision 
Indicates the precision of results merging process. All holes smaller than the Merge precision value 
in a single song will be removed. 
 
Search interval 
Indicates how long SMI will wait before starting a new search process. 
 
Auto re-search (days) 
Indicates how many days the system will 'search back' when a new pattern is added. 
 
Minimal Result length (sec/%) 
Indicates the minimal length of the search result (in seconds, and in % of total length of the track). 
All shorter detections will be removed from results. 
 
Working Path, Commands Path 
Folders containing search results, and other data used internally.  
 
 
Click OK to accept changes, or Cancel to ignore them. 
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SMI Server – Main Search (Fingsearch) Management 
 
Right-click selected station to manage the searching process. 
 

 
 
Select Start/Stop search to control the searching process. 
Select Start/Stop conversion to control conversion process (audio to pre-processed data, from the 
SML archive or the sound card). 
Select Re-search not recognized […] to re-search undetected parts of archive. 
Select Re-search from scratch (all) to delete all results for the station and search the whole archive 
again. 
Select Synchronize with SQL to force data export to the SQL server. 
Select Set all as searched to mark the whole archive as searched. 
 
 
 
 

11 Stirlitz Media Inspector - manual 
 



SMI Server – Patterns management 
 
Use the DBMaint tool to manage the patters database. Click Manage in the Fingerprints Database 
section to launch DBMaint. 
 

 
 
Using this application you can: 

- import new files into the database (File->Add and File->Add Special from menu) 
- edit or remove one or more files (File->Edit, File->Remove, right mouse button (RMB) on 

selected files) 
- see the list of items in the database, filtered by category (Category field), or by matching 

string (Filter field) 
- Group files manually (RMB on selected files) or automatically (Tools->Group by Artist and 

Title). Grouped files will be shown under single name in the search results. This function is 
generally used to group different versions of the same song.  
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SMI Server – using the Web Interface 
 
Station history log – single station mode 
 

 
 
Stations history log – multiple stations mode 
 

 
 
Available filters: 
Date – from/Date – to:  limit the display to the selected period 
Hours – from/to: display items between selected hours only 
Stations: display one or more selected stations 
Category filter: limit displayed items to selected categories 
Cuts longer then: display only items which were played for more than n seconds (use 'n%' to filter 
on percentage) 
Options/Exact mode: change graphical display mode to more time-realistic 
 
Click the selected song title to switch to Cuts mode and get more information about the cut. 
Click Export to export the log to Excel-compatible format.
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Cuts – search 
 
 

 
 
 
 
Cuts - On-air history 
 
 

 

14 Stirlitz Media Inspector - manual 
 



Cuts – Statistics 
 

 
 
 
Cuts – Schedule 
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SMI - Integration with SML 
 
 
Import SMI history logs into SML 
 
To import SMI history logs into SML (version 2.4 or newer) create file named onAirImport.ini in 
main SML Server directory containing: 
 
[Import0] 
Name=StirlitzInspector 
Mode=columns_1l 
FileMask=YYYYMMDD.hist 
datStartTime=0,8 
datStartTimeFormat=hh:mm:ss 
datLength=9,6 
datLengthFormat=s 
datTitle=15,30 
datArtist=46,30 
datCategory=77,16 
 
Restart SML – Config, and select OnAir mode StirlitzInspector in the 'station Edit' dialog. The Log 
path should point to SMI Logs output path for the specific station. 
 
 
Automatic export pre-processed data from SML 
 
To enable automatic export of files from SML (version 2.5p or newer) to SMI : 

- In SML, in station edit window, configure correct folder in Internal audio export field 
- In SMI Main Search, configure the same folder in automatic import option with settings: 

o Metadata import mode: SML 
o Audio decoder: DirectShow 
o Files extension: mp3 

- Start (or restart if running) SMI - Patterns Importer 
 
 
 
 
 
 
 
 For more information check out the Stirlitz Media 

website, or contact us. 
 
 
Stirlitz Media 
www.stirlitzmedia.com 
support@stirlitzmedia.com 
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